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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1

Excerpt from Penn State’s Independent Laboratory Access for the Blind website,
http://ilab.psu.edu/JAWS_Scripts_for_Logger Pro_3.7.doc
(Revised April, 2009)

This documents the scripts prepared by SSB BART Group for use with LoggerPro
3.7.1 and LoggerLite 1.4.1. These scripts were tested with JAWS 7.1 through 10.0
LoggerPro versions 3.5 through 3.7, and LoggerLite 1.4.1. They may work with
JAWS versions as far back as 6.0, but this is not verified. These scripts may also
work with later LoggerPro and LoggerLite versions but will not work well with older
ones. Some features, such as complete announcement of tables and live sensor
readings, will not work as well in LoggerPro versions older than 3.6.1.
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The JAWS Command Key System
How It Works

Most JAWS commands implemented for Logger consist of a prefix key followed by
one or more separate keystrokes. This allows a large number of commands without
conflicting with Logger's native commands. This multi-key system works very much
like a set of standard Windows menus in that commands are grouped into logical
sets. For example, commands that deal with sensors begin with the Command key
followed by the letter S. In this document, such a sequence will be written as
“Command S.”
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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1 (cont’d)

The prefix key that starts JAWS commands, which will from now on be called the
"Command" key, is the left square bracket ([). If it becomes necessary to type a
left bracket into Logger itself, it can be done simply by pressing it twice in
succession. Keys typed after the Command key will only be seen by JAWS, not by
Logger, until the key sequence is exited.

Some key sequences exit when finished, like Windows menus also do. For
convenience though, some do not. For example, the first sensor's current live
reading can be announced via Command S 1. Typing digits right after the 1 will
continue to announce other sensor readings. Pressing any key that is not part of a
sequence will exit the sequence, though Esc is the preferred method for exiting a
sequence that does not exit automatically when finished. JAWS will play a short
door-closing sound whenever a command sequence exits, so the user will be ware
that the sequence is completed and keys will again behave normally.

There are a few JAWS commands for Logger that use the more conventional single-
keystroke approach. Also, most of the multi-key sequences have parallel
conventional commands for those more accustomed to that approach. The single-
key versions of commands, which tend to be CtrI+Shift with letters and numbers,
will be listed in the JAWS Command Reference section of this document.

Keyboard Help For Key Sequences

There is a help system for the key sequences just described. To explore key
sequences, press the Command key and then use Tab to move through the list of
keys you could type next. This is much like arrowing through a Windows menu.
Shift+Tab will move backward through the available keystrokes, and JAWSKey+Tab
(or Insert+Tab) will repeat the most recently described keystroke. This help
system works at all levels of key sequences, so you could, for example, type
Command S and then use Tab to hear about all the commands available that relate
to sensors.

How To Use LoggerPro and LoggerLite With JAWS and the Scripts

This section is intended to help users get started quickly with LoggerPro or
LoggerLite using these scripts. This section is organized by task. Tasks appear as
level 3 HTML headings, so JAWS users can use H or the number 3 to move from
task to task efficiently.
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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1 (cont’d)
Connecting and Testing Sensors

Command S S will give a quick list of sensors that Logger has noticed. Command S L
will also list sensors but with full names and current values for those that provide
live readings. Typing Command S Shift+L will bring up the sensor list in a JAWS
virtual buffer for easy review. If you are working with a new data set, these
commands will help you determine which sensors are connected and set up
correctly.

If you are working with a pre-existing data set, the sensors listed by the above
commands will be the sensors that were attached when the data set was created,
not necessarily the sensors that are currently attached. To get a list of currently
attached sensors, create a new data set (this requirement applies with or without
JAWS).

One way to access a sensor's setup screen is to click on its toolbar item near the
top of the screen. Command S Shift+S will activate the JAWS cursor and place it on
the row of sensor readings, making it easier to find a particular sensor for setup.
(This feature will only work if "Large Toolbar Buttons" is left unchecked in File >
Preferences.)

Some sensors, when connected, cause Logger to add a corresponding digital meter
object to the current page. You can use Ctrl+Tab to move through the available
page objects, or Command O Ctrl+L to pick one from a JAWS list dialog. Leaving
focus on a digital meter will cause JAWS to provide real-time announcements of the
corresponding sensor's value as it changes. The right mouse button JAWS
command, or the Menu key (sometimes also called the Applications or Context Menu
key), provides another way to reach sensor setup dialogs if pressed while a sensor's
meter is in focus.

Command S and then a number from the number row will read specific sensor names
and values. Shifting the number will let you set up automatic continuous
announcement of a sensor's live readings. For example, Command S 3 will read the
third sensor's value, and Command S Shift+3 will bring up a dialog box allowing
you to set up sensor 3 for automatic continuous announcement of readings. To
disable automatic continuous announcement of a sensor's readings, just bring up
the setup box again, then cancel it with Esc. Note that this method of automating
sensor reading announcements will repeat the sensor's value at specified intervals
whether it has changed or not, whereas the above digital meter method will say
nothing until the sensor's value actually changes.

In the LabPro Setup dialog, Command S S will list all LabPro channels and announce
what is attached to each. Command S Shift+S will present this information in a
JAWS list box instead of just reading it aloud.
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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1 (cont’d)
Starting and Stopping Collection

Command S S will indicate whether data is currently being collected, in addition to
listing sensors. JAWS will also announce automatically when collection starts and
stops. The announcements may be slightly delayed if data collection significantly
impacts the CPU.

Use JAWSKey+Tab before starting collection to make sure focus is not on a data
table. If it is, use Ctrl+Tab to move focus to a different item on the current page.
Collecting while in a data table may produce a lot of extra speech as the table
continuously expands.

The Space bar usually turns data collection on or off but may not work in a data
table and sometimes fails to stop collection even when focus is not in a table.
Command S C, or CtrlI+Shift+C, will work everywhere and will better announce
what is happening.

Managing Objects On a Page

Ctri+Tab will move cyclically through the objects on the current page, announcing
each object as it acquires focus. JAWSKey+Tab will repeat the currently focused
object's information, and a double JAWSKey+Tab will bring details about this object
into a JAWS virtual buffer for easy review.

Command F followed by a digit will read a specific field of information about the
currently focused object. This is most useful with statistical objects as a way of
quickly checking specific statistical values. For example, Command F 3 will read the
third field of information about the currently focused object. If that object is a
statistical object, the third field might be the minimum Y-axis value and where on
the X axis it occurred.

When an object is in focus, there will be a corresponding option in the Options
menu available that provides access to the object's properties. Use this to set up
any special settings for the object, such as column names for tables, axis
specifications for graphs, etc. The right mouse button command or the Menu key
can be used to gain access to the object's properties as well, but it may first be
necessary to bring the object to the front of the Z order so it is not covered by
other objects. This can be done with Command O F. Using the Options menu should
avoid this issue though, so the Options menu is the recommended approach.

Command O L will list the objects on the current page, such as tables, graphs, digital
meters, etc. Logger adds objects automatically as sensors are connected, and users
can add objects as well, such as thermometers, gauges, statistical objects,
integrals, etc. Command O Shift+L will bring up the object list in the JAWS virtual
buffer for easy review.
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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1 (cont’d)
Managing a Data Table

Note: Navigation may not begin on the first cell when you first try navigating in a
particular table.

Use the four arrow keys to move among table cells. Use Ctrl+PgUp and Ctrl+PgDn
to move up or down quickly 20 rows at a time. As you navigate up and down, you
will hear the row number and the current cell's value. When navigating left and
right, you will hear the column name and the cell value. Note that left and right
arrows wrap to new lines when you try to arrow past the left or right edge. This is a
Logger behavior.

Managing Pages In a Multi-Page Project

Use PageUp and PageDown to move among pages of a multipage data window.
JAWS will announce the page number, page count, and page title (if any) when the
page changes. The SayTitle command, JAWSKey+T, will also announce this
information when focus is in the data window. The Page menu contains many useful
page-related options, including a way to add pages and a way to jump directly to a
specific page.

Miscellaneous Tasks and Features

JAWSKey+F1, when typed in a data window, will bring up a JAWS virtual buffer
containing a lot of information about the current page. The following items are
included:
e An indication of which page is currently showing, the page title if any, and
the number of pages in the data window.
¢ A list of all objects shown on the current page, with all information available
about each. For digital meters, this includes current readings at the time you
typed JAWSKey+F1. For statistical and analysis objects, this includes the data
shown by those objects, such as integrals, slope equations, quadratic

coefficients, etc. This is more information for each object than shown by
Command O L

e A list of all sensors associated with the current project (similar or identical to
the information shown by Command S L).

Use a double JAWSKey+F1 to display the help document you are currently viewing in
your default browser.

If you encounter a list or combo box that is hard to use because focus won't stay in
it when you arrow among options, press F4 twice quickly and then select your
choice from the JAWS list that pops up. (F4 was chosen because it naturally opens
combo box dropdowns; pressing F4 once will do what it normally would have done
without scripts running.)
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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1 (cont’d)

The left and right mouse button keys will, if pressed when the PC cursor is active,
click on the currently focused object (table, graph, meter, etc.). The SayCharacter,
SayWord, SaylLine, RouteJAWSToPC, and RoutelnvisibleToPC commands will also
address the currently focused object.

User-Transparent Script Features

The scripts improve JAWS' ability to name correctly a number of fields scattered
throughout Logger.

JAWS will automatically announce various error conditions, such as when trying to
apply a Curve Fit to a graph without selecting enough points or when trying to
communicate with a LabPro on a port with nothing attached.

If a digital meter includes an alarm condition and that condition is met, the screen
text in the meter turns red. JAWS will begin saying "alarm!" before reading the
meter's text in such a situation. "Alarm!" should also appear in Braille for the meter
where applicable. This feature requires LoggerPro 3.6.1 or later and will not work in
older LoggerPro versions.

During import operations, JAWS will announce context-sensitive instructions and
changes in the status of the process.

Some LoggerPro list controls do not read correctly without help, so the scripts
include code to make these boxes behave normally with JAWS.

The scripts make the JAWS automatic graphics labeler work in LoggerPro though it
otherwise would not. It may be necessary to enable all graphics to be spoken
before attempting this, though users should not have to do this themselves
anyway. The scripts already include labels for the main tool bar at 16-bit and 32-bit
color depths, and toolbar items can also be invoked from menus under the menu
bar.

Several little tunings are included for the LoggerPro help system: AIt+B and
Alt+LeftArrow go back to the previously shown help page, Alt+RightArrow does
the opposite just as in Internet Explorer, and JAWS should not repeat highlighted
search terms while navigating through help pages right after you search for key
words.

JAWS will spell "T I" instead of saying "ti." Several other custom pronunciation fixes
are also included.
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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1 (cont’d)
JAWS Command Reference
This section lists JAWS commands unique to Logger. Standard JAWS commands

that are enhanced for Logger but which function in other applications are not
included here. Examples of these include JAWSKey+Tab and JAWSKey+F1.

Categor Function Command System Conventional
gory Keystrokes Keystroke
Cycle through and announce .
Scstrgrr:?]ré? possible keystrokes at the Tab or th |If\7+ITab at N/A
y P lcurrent command level any leve
Repeat the Iast?s_p_oken JAWSKey+Tab N/A
command possibility
Exit the command system Esc or any key that is
. ) N/A
without executing a command not a command
Sensors Summarize current screen Command S S Ctri+Shift+S

(includes quick sensor list)
Move mouse to sensor list on

screen, or show LabPro . Ctril+Shift+S
’ + i .

channel list in a JAWS virtual Command S ShifTt+S twice quickly

view

'aztaicl"””e“ed sensors in Command S L Ctri+Shift+A

Say a specific sensor reading | Command S digit Ctrl+Shift+digit
Set up automatic

announcement of sensor Command S Ctri+Shift+digit
, Shift+digit twice quickly
readings
Toggle collection on/off Command S C Ctri1+Shift+C
Objects {\C/I)?\rlgnct:urrently selected object Command O F Ctri+Shift+F
Say the list of objects on the command O L Ctri+Shift+0

current page

Virtualize the list of objects on command O Shift+L Ctr_I+Sh|_ft+O
the current page twice quickly

Say the value of a specific field Command F digitor

Object fields |of information about the Command F N/A
currently selected object Shift+digit
Miscellaneous tsalglrg down 20 rows in a data N/A Ctrl+PgDn
Skim up 20 rows in a data N/A Ctri+PgUp
table
Open a combo box N/A F4
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APPENDIX 111: JAWS Scripts for LoggerPro 3.7.1 (cont’d)

Known Issues For Vernier's Attention

The following issues would need to be addressed by Vernier in a future version of
Logger. They can not be addressed, or at least not as safely or easily, via JAWS
scripting.

There are a few fields that are skipped by the Tab and Shift+Tab keys

Some sets of radio buttons in LoggerPro do not allow arrow keys to select a
choice. For these, use of the JAWS cursor to click the desired option is
required

There is no known way to jump to the top or bottom of a table with keyboard
commands

Arrows can move focus to cells way below the bottom of existing data. (This
may be intentional and not a problem but is worth mentioning because it is
unusual for table controls)

Shift+Tab moves forward, not backward, through table cells. Arrows work as
expected though

Ctri+Shift+Tab does not move through objects in the reverse order of
Ctrl+Tab

Left and right arrows, when pressed at the left and right edge of a row,
respectively, wrap to the next row in the corresponding direction instead of
stopping as is the case in many other applications. This may be preferred by
some users but is unusual enough to deserve mention.
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APPENDIX 1V: Using LabPro Remotely

Having a computer or calculator attached to LabPro during data collection is
preferable, because it provides much more flexibility in your data collection and
provides a screen for immediate feedback of your results. There are times,
however, when disconnecting LabPro from the computer or calculator to collect data
is useful. For example, remote data collection is perfect for gathering acceleration
data on a roller coaster. The following describes remote data collection with
LoggerPro 3 on a computer.

There are 3 buttons on the LabPro interface: Transfer (left), Quick Setup (centre),
and Start/Stop (right). When the unit is battery powered and unplugged from the
LoggerPro software, if you press the Quick Setup button, it will collect 99 points of
data, about 5 seconds worth. If you require a different amount of time or require
the data points to be spread further apart, follow the following instructions for time-
based.

Set Up for Time-Based Method

Using the Set Up for Time Based Method, you connect the LabPro to a computer to
set it up, detach it for a real time data collection, and then re-attach it to the
computer to retrieve the data. This gives you more flexibility than the Quick Setup
method. With this method, you can (a) use any sensors (not just auto-1D), (b)
control the time between samples, and (c) control the number of data points
collected (up to about 12,000).

1. Set up LabPro for remote data collection:

a. Put fresh batteries in the LabPro.

b. Set up the sensors, LabPro, and LoggerPro just as you normally would to
collect data in Time Based mode. Use Ctrl-d to change the information in the
data collection pop-up menu.

c. Before detaching the LabPro, go to the Experiment menu, select Remote,
then Setup. A summary of your setup will be displayed.

d. Tab to Ok and press enter to prepare the LabPro.

e. When LoggerPro prompts you, disconnect the LabPro from the computer.

f. If it has not already been saved, save the experiment file so it can be used to
later retrieve the data from LabPro.

2. Collect data:

a. When you are ready to collect data, press the START/STOP button (at the
right). Do not press the Quick Setup button (centre) or it will change the
settings that were changed on the computer.

b. When data is collecting, a green light will flash; when the data collection is
complete, the yellow LED will flash briefly. You can also stop data collection
early by pressing the START/STOP button before data collection is finished.
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APPENDIX 1V: Using LabPro Remotely (cont’d)

3. Retrieve the data:

a. Start LoggerPro if it is not already running. If the “Continue Without

Interface” dialog appears, tab to Ok and press enter.

b. Open the experiment file used to set up LabPro.
Attach the LabPro to the computer.
If a Remote Data Available window appears, tab to the YES button and press
enter. Another dialog will appear clarifying how the data is to be transferred;
select the radial button of your choice and tab to Ok and press enter. If a
window does not appear when the interface is reconnected, go to the
Experiment menu, select Remote, then Retrieve Remote Data and follow the
on-screen instructions.
e. The data will be retrieved.

o o
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APPENDIX V: Braille Chart for Rainin AutoRep M

Included in the documentation for this manual-repeating pipette is a reference
chart in print — as well as a micro-print version on the backside of the pipette. This
chart assists the user in selecting which tip to dispense a specific amount of
solution, and which stepped setting (1-5) to choose.

The following page is the braille equivalent of this same chart, with all measures
converted from micro-litres (uL) to milli-litres (mL). It can be printed onto
microcapsule paper and processed through a heat-device (e.g. a PIAF, or Pictures-
in-a-Flash — see above); the braille dots will ‘swell’ up to form a tactile braille
reference page for the student to use. At the time of this resource’s publication, the
PIAF is available for loan through the Learning Resources Centre (LRC).
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APPENDIX VI: WHMIS Symbols in Braille
Compressed Flammable Oxidizer Poisonous
Gas
Toxic Biohazard Corrosive Reactive

Similar to the previous appendix which included a reproducible braille reference
page, the following two pages are common WHMIS symbols students may
encounter during laboratory experiments; these can be reproduced in tactile braille
when printed or photocopied onto microcapsule paper and used with the PIAF.
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APPENDIX VI1I: Excerpts, Manufacturer User Manuals

The following pages have been borrowed (with permission) from the manufacturer
websites to assist with the various equipment listed in Sections 3-6 of this resource.

Thank you for using this resource!
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